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Thank you for purchasing the Minolta Dimâge-Pic with the Dimâge-Pic image
control software. This software is the driver software for exchanging data
between the camera and your computer. The software enables you to:

• Display thumbnail previews of images on the computer monitor.
• Copy camera images to your hard drive or removable media (floppy disk).
• Delete images stored on the camera. Trigger the camera’s shutter remotely

with the computer.
• Save your images in a variety of convenient file formats.
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Please take the time to read through this instruction manual so you will be able to take
full advantage of the features.

This manual assumes you have a working knowledge of Windows® and its operating
conventions. Familiarity with the mouse and standard Windows® menus and
commands is necessary before operating the Dimâge-Pic image control software. This
manual does not instruct in the basic use of personal computers, Windows® 95, or
Windows® 3.1.

The examples in this manual use Windows® 95. The appearance or commands of
some screens may differ from the examples when using windows® 3.1.

Windows®, Windows® 95, and Windows® 3.1 are registered trademarks of Microsoft
Corporation. The official name for Windows® is Microsoft® Windows® Operating System.

Every necessary precaution has been taken to ensure the accuracy of this manual.
Please contact us if you have any questions, find any mistakes, or notice missing
information. Minolta is not responsible for loss, damage, or other results caused by
operation. No part of books, magazines, music, or other productions that were released
under copyright may be used, copied, or changed without the prior permission of the
author, copyright holder, or the successor to the copyright holder except for personal,
home, or equivalent use.
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BEFORE YOU BEGIN
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Check the packing list before you begin. If some parts are missing, contact
your camera dealer or a Minolta Service Facility.

• Dimâge-Pic Digital Camera • Serial Cable SC-P1W for Windows
• Video Cable VC-P1 • Serial Cable SC-P1M for Macintosh
• Camera Case CC-P1 • Hand Strap HS-P1
• Warranty/Product & Software Registration Card
• Dimâge-Pic Image Control Software CD-ROM

CHECKING THE PACKING LIST                                             

SOFTWARE REGISTRATION                                                  
Please register this software before using it.

You will receive technical support, as well as software upgrade and product
information once this software is registered. Complete and return the
enclosed Product & Software Registration form after detaching it from the
Warranty. No postage is necessary.

• The information provided in the questionnaire will only be used for Minolta
customer service and product research & development. The information you
provide will be kept private and confidential.

SYSTEM REQUIREMENTS                                                     
To use the Dimâge-Pic image control software, you need:

• IBM PC/AT compatible with a 486 or higher processor.
• Microsoft Windows 95, Windows for Workgroups 3.11, or Windows 3.1.
• A minimum of 16MB available RAM.
• A minimum of 17MB available hard disk space.
• SVGA monitor (with true-color display card).
• CD-ROM drive.
• RS-232C serial port with high-speed card (D-sub 9-pin).
• Mouse or other pointing device.



INSTALLING THE SOFTWARE
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WINDOWS 95                                                                         
The installation instructions assume the CD-ROM drive is the D drive and the
hard disk is the C drive.

1.Turn on the computer and start Windows 95.

2. Insert the Dimâge-Pic Image Control Software CD-
ROM into the CD-ROM drive.

3.Select Run... from the Start button.
• The Run dialog box will appear.

4.Type D:\IMSCAM\Win95\Setup.exe in the Open drop-
down list, then click on OK.
• The Welcome dialog box will appear.

5.Click on Next> .
• The User Information dialog box will appear.

6.Enter the required information, then click on Next> .
• The Registration Confirmation dialog box will appear.

7.Click on Yes.
• The Select Components dialog box will appear.

Type 
D:\IMSCAM\Win95\Setup.exe

Click to select
another directory.

The software will
be stored in this
directory.

✎ When uninstalling the software, be sure to delete the c:\imscam folder. It is not
removed by the uninstaller.

10. When installation is complete, the following message 
will appear. Click on OK.

8.Confirm the Destination Directory, then click on
Next> .
• The Select Program Folder window will appear.

9.Confirm the folder name, then click on Next> .
• The Setup window will appear and a bar graph will report progress.
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CONNECTING
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INSTALLING THE SOFTWARE

Use the SC-P1W serial cable, included in this package, to connect the
Dimâge-Pic to your computer.

1.Turn off the Dimâge-Pic and
your PC.

2.Open the terminal cover as
shown.

3. Insert the jack-plug end of the
serial cable into the digital out
terminal on the camera.

4.Plug the D-sub 9-pin end of
the cable into the serial port
(COM port) of the computer.
• Make sure the cable is securely attached

to the camera and the computer.

WINDOWS 3.1                                                                        
The installation instructions assume the CD-ROM drive is the D drive and the
hard disk is C drive.

1.Turn the computer on and start Windows.

2. Insert the Dimâge-Pic Image Control Software CD-
ROM into the CD-ROM drive.

3.Select Run.. from the File menu in the Program
Manager and type D:\IMSCAM\Win31\Setup.exe in the
Command Line box. Click on OK.

• The Welcome dialog box will appear. Click on Next> .
• The Choose Destination Location dialog box will appear.

4.Confirm the destination, then click on Next> .
• The Select Components dialog box will appear.

5.Click on Next> .
• The Setup window will appear with a bar graph to report progress.
• A message informing you the install is complete will appear. Click on OK.
• A message informing you setup is complete will appear. Click on Finish .

✎ When uninstalling the software, be sure to delete the c:\imscam folder. It is not
removed by the uninstaller.

✎ It may be necessary to specify the selected COM port in Setup (p 11).
✎ If the cable is disconnected during operation: turn the camera off, connect the

cable, then turn the camera back on.
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STARTING THE APPLICATION
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IMS CAMERA MAIN WINDOW

1.Connect the camera to the computer (p 7).

2.Turn the camera on, then turn the computer on.

3.For Windows 95:
From the Start button, select Programs , then select

from the submenu and from
the second submenu.

For Windows 3.1:
Double-click on the IMS Camera program group in the
Program Manager, then double-click on the IMS
Camera icon.

• The IMS Camera main window will open.

The graphical user interface lets you recognize functions
at a glance.

Status Bar:
Gives hints and
information.

Thumbnail Display
of an item.

Camera
Icon

Folder

Tool Bar (p 10)Menu Bar

Trash Can (p 20)

Empty

Items
inside

✎ Use the functions in the View menu to show or hide the Name Boxes (for
folder items only), Toolbar, or Status Bar.

Name Box
Rename by
clicking on
current name.
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SETUPMAIN WINDOW TOOLBAR

New Folder - Create a new folder. Rename the folder by clicking
on the current name.

Delete Folder/Erase All Pictures - Put the selected folder and
contents in the trash/permanently erase the camera images.

Add Item - Add an image file from the hard disk or floppy disk to
the selected folder.

Delete Item - Delete an image from the folder or erase an image
from the camera.

Find - Find an image within the IMS Camera software.

Export - Copy an image from a folder to another location on the
hard disk or to a floppy disk.

Take a Picture - Trigger the camera’s shutter remotely. The
camera must be in REC mode.

Rotate 90° - Rotate an image in a folder 90° clockwise.

Print Current Folder - Print a ‘contact sheet’ of all the thumbnail
displays in the selected folder.

Help - Display the Help Topics for IMS camera.

Before downloading the images from the camera to a folder (p 13), you
should first confirm the Setup settings. The settings will determine the size
and file type of the final image.

1.From the Tools menu, select Setup... .
• The Setup dialog box will appear.

2.Enter the desired settings, then click OK.

✎ The entered settings apply to the downloaded images. The images inside the
camera are not changed. You can change the settings and download more
images (or the same images) using different settings. 

✎ File Formats: BMP images are supported by Windows through Microsoft Paint.
JPG images are compressed, so the file size is smaller. TIF is a widely
supported format capable of maintaining professional-quality color.

✎ The default COM port setting is Auto. Use the Settings dialog box to select a
specific COM port if necessary.

11

Picture Size
Affects the size when downloading
images.

Baud Rate (in bits/second)
Determines the transmit speed
from the camera to the software.

Picture Format
Determines the file format when
downloading images.

COM Port
Specifies the serial port (COM port)
to be used by the Dimâge-Pic.
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DOWNLOADING CAMERA IMAGESVIEWING CAMERA IMAGES

The folders inside the main window make it fast and easy to download
images from the camera. The folder images can also be accessed quickly so
they can be exported (p 18) or printed (p 24).

1.Click on the image to be downloaded to the folder.
• Select multiple images by pressing the Ctrl key while clicking on images.

Select groups of images by clicking on the first and the last images while
pressing the Shift key. Deselect an image by clicking on it again while
holding the Ctrl key.

• A border will appear around the selected images.

2.Drag the image to the folder icon, then drop it in.
• Images placed in the folders are saved on the hard disk in c:\imscam\data . 
• The image will be saved in the file type and size selected in setup (p 11).

DOWNLOADING TO A FOLDER                                            

3.Click on the folder to view thumbnail displays of the
folder contents.

4.Double-click on a thumbnail to see the full-size image.
• The Viewer window will open and the full-size image will appear (p 21).

Click here to
connect to the
camera.

Connected

Not Connected

Connected 
and open

Display thumbnail previews of the images in the camera.

1.Click on the camera icon.
• The software will connect to the camera and begin downloading images to

the IMS Camera main window.

2.Double-click on a thumbnail image to zoom in.

Double-click to enlarge the view.

Click to return to
the main window

✎ If the thumbnails and images appear abnormal, select a lower baud rate in
Setup (p 11), then click on the camera icon again.
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FOLDERS
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CREATING/NAMING A FOLDER                                              

1.Click on the New Folder button in the toolbar.
• The new folder will appear in the folder area.

ADDING ITEMS TO A FOLDER                                               
1.Add new items to the folder by clicking on the New Item

button in the toolbar.
• The Add Item dialog box will appear.

2.Select the desired item from the appropriate directory,
then click on Open .
• Only JPG, TIF, and BMP files can be added. Do not attempt to add JPG or

TIF files that are not in RGB or grayscale mode.

DELETING A FOLDER                                                            
Click on the folder to select it, then click on the Delete
Folder button in the toolbar.

• The entire folder contents will be moved to the trash can (p 20).

DELETING ITEMS FROM A FOLDER                                      
1.Select the item to be deleted by clicking on the thumbnail.

• Select multiple images by pressing the Ctrl key while clicking on images.
• A border will appear around the selected item.

2.Click on the Delete Item button in the toolbar.
• The item will be moved into the trash can (p 20).

Folder items can be renamed at any time.

Click on the item name to highlight it, then type in the
new name.

RENAMING FOLDER ITEMS                                                   

2.Click on the folder name to highlight it, then type in the
new name.

✎ Folders can be renamed at any time.

Click to highlight,
then type in the
new name.

✎ Two items of matching file types cannot share the same name, even if they are in
different folders.

Click to highlight,
then type in the
new name.

MOVING/COPYING FOLDER ITEMS                                       
Move items between folders by dragging them and dropping them into their
new location. Select multiple items by pressing the Ctrl key while selecting.

Copy items by pressing the Ctrl key while dragging and dropping them into
another folder.

Continued on next page.



ROTATING IMAGES
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FOLDERS 
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SAVING YOUR WORKSPACE                                                 

FINDING FOLDER ITEMS                                                       
The find command makes it possible to search for an item by name without
having to look through each folder.

1.Click on the Find button in the toolbar.
• The Find dialog box will appear.

Your workspace is the collection of folders and items in the IMS Camera
main window. When IMS camera is closed, changes made in the folders
(new/deleted folders, added/deleted items) are automatically saved.
However, should the application quit unexpectedly (power to the PC is turned
off, the PC crashes) the changes will be lost. To protect the workspace
changes without closing the application, save the workspace often.

From the File menu, select Save Workspace .

2.Enter the name of the item you want to find and click
on the desired option buttons and check boxes.

3.Click on Find N ext .

Up - the search will start at
the last folder/last image.
Down - the search will start
at the 1st folder/1st image.

Rotate images in a folder in 90° increments.

1.Click once on the desired image to select it.

2.Click on the Rotate button in the toolbar.
• The image will rotate 90° clockwise.

✎ Continue clicking on the Rotate button to rotate the selected image 180° and
270° clockwise.

✎ The rotate function can also be selected from the Tools menu.



REMOTE CAMERA OPERATION
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EXPORT/SAVE 
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Images in a folder can be saved to the directory of your choice.

1.Select the thumbnail of the desired image by clicking
on it once.
• Only one image at a time can be selected for export.

2.Click on the Export button in the toolbar.
• The Export dialog box will appear.

3.Select the directory where the file will be saved and
enter the desired file name in the File n ame box.

4.Click on Save.
• The image will be saved in the selected directory. 

✎ The image will be saved in the file type selected in setup when it was
downloaded to the folder (p 11).

Take pictures with the camera from your computer.

1.Use the camera’s record/play switch to set the camera
to REC.

2.Click on the camera icon in the main window.

3.Click on the Take a Picture button in the toolbar.
• When the camera is finished processing, the thumbnail display for the new

image will appear automatically.

Erase selected images from the camera or delete all of the camera contents.
ERASING IMAGES                                                                 

1.Use the camera’s record/play switch to set the camera
to PLAY.

2. If deleting selected images, select the image to be
deleted by clicking on the desired thumbnail.
• A border will appear around the selected item.

3.Click on the Delete Item button in the toolbar. If
erasing all the images, click on the Erase All Pictures
button in the toolbar.
• A message will appear, asking you to confirm. Click on OK.

✎ You can also delete images from the camera by dragging and dropping them
onto the trash can (p 20). Unlike folder images, images from the camera
cannot be recovered from the trash can; they are permanently deleted.

TAKING PICTURES                                                               

The available file type will vary with the Setup settings
used when the image was downloaded (p 11).

Choose the destination
directory.

Name the file.



VIEWER WINDOW
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TRASH
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THROWING AN ITEM OR FOLDER AWAY
Drag and drop selected items or folders onto the trash can.
• For camera images: A confirmation message will appear. Camera images are

permanently deleted when they are put into the trash.

VIEWING TRASH CAN CONTENTS                                         

Double click on the trash can.
• The Delete dialog box will appear.

EMPTYING THE TRASH CAN                                                 
1.Click on the name of the item in the Delete window.

2.Click on Remove Selected , then click on OK.
• You can also click on Clear All to delete all the items in the trash can.

RESCUING ITEMS FROM THE TRASH                                   
1.Click on the name of the item in the Delete window.

• You can also click on Select All to select all the items in the trash.

2.Click on Undelete Selected , then click on OK.
• The item will be returned to the folder from which it was removed.

Display the full-size image of a folder item.

Double-click on the thumbnail preview of a folder item.
• The Viewer window will automatically appear with the full-size image.

VIEWER WINDOW TOOLBAR                                                 

Open File

Print Setup

Print

View 100%

Enlarge view
by 200%

Reduce view
by 50%

Information

Arrow

Scroll

Zoom In

Zoom Out

Continued on next page.

Magnifier

Show/Hide
Full Image

OPENING                                                                               

✎ Use the functions in the View menu to show or hide the Status Bar, Toolbar, or
Full Image window.
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VIEWER WINDOW
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When an item is displayed in the Viewer window, click on the 

Information button in the toolbar to display information about the file.

IMAGE INFORMATION                                                          
Use the Magnifier tool to view a section of the image close-up.
MAGNIFIER                                                                            

1.Click on the Magnifier button in the toolbar.
• The Magnifier window will appear and a rectangular marquee will appear

inside the main image window.

2.Click the mouse to change the position of the magnifier,
or drag the magnifier to any location.
• The area inside the magnifier will appear in the Magnifier window. The

magnification ratio is 1:4 (400%).

✎ Click on the Arrow button to cancel the Magnifier.

Magnifier
window

Marquee
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PRINTING
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Print an image from a folder.
PRINTING SELECTED IMAGES                                              PRINTING A CONTACT SHEET                                              

Print all the thumbnail displays for a selected folder. Approximately 36
thumbnails will fit on a letter size page.

1.Click on the desired folder.

2.From the File menu, select Print Setu p.
• The Print Setup dialog box will appear.

3.Select a printer, the paper size, and image orientation,
then click on OK.

4.Click on the Print Folder Contents button in the tool
bar.
• The following Print dialog box will appear.

PRINT SIZE
1 to 1: The image is printed
using the printer resolution.
Actual Size: The image is
printed using the resolution
and dimensions of the image.
Fit to Page: Printed image
will match the paper size.
Scale: The image can be
printed to a size of 50 - 200%
of actual size.

1.Double-click on the thumbnail to display the image in
the Viewer Window (p 21).

2.Select the Print Setup button in the Viewer window.
• The Print Setup dialog box will appear.

3.Select a printer, the paper size, and image orientation,
then click on OK.

4.Select the Print button in the Viewer window.
• The following Print dialog box will appear.

5. Choose the print size and the number of copies.

6. Click on OK to print the image. 5.Enter the desired options, then click OK.
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TROUBLESHOOTING

What do the error messages mean?

• Camera disconnected or processing. Please check camera status.
• Failed to load pictures.
• The camera is not responding. Please make sure the camera is

connected and powered on.

These messages can appear for different reasons:
- The camera is turned off or has no power. Check the AC Adapter or 

battery condition. Auto Power Off activates if the camera has not been 
used for 2 minutes.

- The serial cable is not properly connected.
- The wrong COM port is selected in Setup (p 11).
- The camera is still processing a picture that was just taken.
- The transfer rate is improper. Change the Baud Rate in Setup (p 11).

• Please set at REC mode to take a picture.

- The record/play switch on the camera is set to PLAY. Slide it to REC to 
take pictures.

• Can’t rename item as [xxx].

- A file with this name already exists in one of the folders or in the trash, 
the original file cannot be opened, or the item cannot be converted to the 
selected format.

• Warning. Not recognizable bmp format.

- IMS Camera does not recognize the file contents in this format. 

• Warning. Not recognizable tif format.

- IMS Camera does not recognize the file contents in this format. The TIFF
image is not RGB or grayscale mode. 

• Warning. Not recognizable jpg format.

- IMS Camera does not recognize the file contents in this format. The JPEG
image is not RGB or grayscale mode. 

• Selected item is already in folder. To add this file into folder anyway,
please delete or rename existing item at first.

- An item with the same name and file type exists in one of the folders or in   
the trash.

• Some items do not exist, they will be removed from record!

- An item has been deleted from the hard drive/floppy disk. Its thumbnail 
display will be removed.

• Not enough disk space in driver A:\.

- The file size is greater than the available disk space.

• Not supported image type.

- The file is not in bitmap (BMP), JPEG (JPG), or TIFF (TIF) format.

If the thumbnail previews and images appear abnormal, select a lower baud
rate in Setup (p 11), then click on the camera icon again.
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